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Using the vCenter Orchestrator Plug-In for vCloud
Director 1.0

Using the vCenter Orchestrator Plug-In for vCloud Director 1.0, provides information and instructions about
®
®
configuring and using versions 1.0.1 and 1.0.2 of the VMware vCenter Orchestrator plug-in for VMware
vCloud Director.

Intended Audience
This information is intended for anyone who is installing and configuring the plug-in, using the API of the
plug-in, and running sample workflows. Using the vCenter Orchestrator Plug-In for vCloud Director 1.0 is written
for experienced users who are familiar with virtual machine technology, with Orchestrator workflow
development, and with vCloud Director.
For more information about Orchestrator, see
http://www.vmware.com/support/pubs/orchestrator_pubs.html.
For more information about vCloud Director, see http://www.vmware.com/support/pubs/vcd_pubs.html.
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Introduction to the VMware vCenter
Orchestrator Plug-In for vCloud
Director

1

The vCloud Director plug-in (VMware vCenter Orchestrator plug-in for vCloud Director) allows interaction
between vCenter Orchestrator and vCloud Director.
You can use the plug-in to run Orchestrator workflows that automate vCloud Director processes. The plug-in
contains a set of standard workflows. You can also create custom workflows that implement the plug-in API
to automate tasks in your vCloud Director environment.
This chapter includes the following topics:
n

“vCloud Director Plug-In Components,” on page 7

n

“Installing and Configuring the vCloud Director Plug-In,” on page 8

vCloud Director Plug-In Components
The vCloud Director plug-in relies on a number of components to function properly.
vCenter Orchestrator and vCloud Director provide the platform for the plug-in, and the plug-in provides
interaction between those products.
Figure 1-1. Component Relations

User API
Admin API
Admin Extensions API

vCloud plug-in

vCloud Java SDK

HTTP/REST

vCloud Director

vCenter Orchestrator

The vCloud Director plug-in implements the User, Admin, and Admin Extensions API classes that correspond
to the types of API classes in vCloud Director. All users can read User API classes and users with appropriate
rights can modify these classes. Users with administrative rights can modify Admin API and User API classes.
The Admin Extensions API classes are VMware-specific and only system administrators can modify these
classes. System administrators can also modify Admin API and User API classes.
The vCloud Java SDK provides the communication platform between the JavaScript API of the plug-in and
the vCloud Director REST API.
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Role of vCenter Orchestrator with the vCloud Director Plug-In
You must use the Orchestrator configuration interface to install and configure the vCloud Director plug-in.
You use the Orchestrator client to run and create workflows and access the plug-in API.
The vCloud Director plug-in is powered by vCenter Orchestrator 4.1. Orchestrator is a development and
process-automation platform that provides a library of extensible workflows to manage the VMware vCenter
infrastructure and other technologies.
Orchestrator allows integration with management and administration solutions through its open plug-in
architecture. vCloud Director is one example of an administration solution that you can integrate with
Orchestrator by using plug-ins.

Plug-In Interaction with vCloud Director
You use the plug-in to run Orchestrator workflows that interact with vCloud Director to perform automated
tasks in the vCloud infrastructure.
With vCloud Director, you can build secure, multitenant clouds by combining virtual infrastructure resources
into virtual datacenters. The virtual datacenters are a fully automated, catalog-based service that users access
through Web-based portals and programmatic interfaces.

Installing and Configuring the vCloud Director Plug-In
You must use the Orchestrator configuration interface to install and configure the vCloud Director plug-in.

vCloud Director Plug-In Functional Prerequisites
To be able to install and use the vCloud Director plug-in, your system must meet the following product
prerequisites.

vCenter Orchestrator
Verify that you have a running instance of Orchestrator. You can log in to the Orchestrator configuration
interface at http://orchestrator_server:8282. Versions 1.0.1 and 1.0.2 of the plug-in work with vCenter
Orchestrator 4.1.
For information about setting up Orchestrator, see the vCenter Orchestrator Installation and Configuration
Guide.

vCloud Director
Verify that you have access to a vCloud Director instance. You can test your user credentials at
https://vcloud_director_server. Versions 1.0.1 and 1.0.2 of the plug-in work with vCloud Director 1.0 and 1.0.1.
For information about setting up vCloud Director, see the vCloud Director Installation and Configuration Guide.

Install the vCloud Director Plug-In
To be able to use the vCloud Director plug-in, you must download the .vmoapp file containing the plug-in and
install it using the Orchestrator configuration interface.
Prerequisites

8

n

Verify that you are logged in to the Orchestrator configuration interface at http://orchestrator_server:8282.

n

Verify that you have downloaded the .vmoapp file from
http://www.vmware.com/products/datacenter-virtualization/vcenter-orchestrator/plugins.html.
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Procedure
1

On the General tab, click Install Application.

2

Upload the vCloud Director plug-in.
a

Click the magnifying glass icon.

b

Select the .vmoapp file to install.

c

Click Open.

d

Click Install.

The vCloud Director plug-in tab appears in the Orchestrator configuration interface.
3

On the Startup Options tab, click Restart service to complete the plug-in installation.

Configure the vCloud Director Plug-In
To be able to manage vCloud Director instances by using the vCloud Director plug-in, you must configure the
connection parameters for each vCloud Director instance.
Prerequisites
Verify that you are logged in to the Orchestrator configuration interface at http://orchestrator_server:8282.
Procedure
1

Click vCloud Director.

2

Click New vCloud Director Connection.

3

From the Available drop-down menu, select Enabled.

4

In the Host text box, type the IP address or the DNS name of the vCloud Director instance.

5

In the Port text box, type the port number.
The default port is 443.

6

(Optional) Modify the SSL connection settings.
Leave the Secure channel check box selected to establish a secure connection to the vCloud Director
instance.

7

In the Maximum connections text box, type the maximum number of concurrent connections to the
vCloud Director instance.

8

Specify the method you use to manage user access on the vCloud Director instance.
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Option

Action

Session per user

CAUTION Each user who logs in to Orchestrator creates a new session to the
vCloud Director instance. Multiple sessions can rapidly strain CPU, memory
and bandwidth.
Select this option if your vCloud Director is in an Active Directory domain.
Make sure that the user has the necessary permissions to perform the
required operations.

Share a unique session

Select this option to allow Orchestrator to create only one connection to the
vCloud Director instance. Type the credentials of a user who is a vCloud
Director administrator.

9
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10

In the Organization text box, type the name of the organization that users can access.
n

If you type System, administrators can run User API, Admin API, and Admin Extensions API
operations in all organizations on the vCloud Director instance.

n

If you type the name of a specific organization, administrators can run only User API and Admin API
operations in the specified organization.

10

Click Apply changes.

11

Repeat Step 2 through Step 10 for each vCloud Director instance.
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vCloud Director Plug-In Scripting API

2

The vCloud Director plug-in scripting API contains classes, with their respective attributes and methods, that
allow interaction between vCenter Orchestrator and vCloud Director. The scripting API maps the classes of
the vCloud API to Orchestrator JavaScript classes that you can use to develop custom Orchestrator workflows
that interact with vCloud Director.
The main categories of API classes are User API, Admin API, and Admin Extensions API. With the User API,
you can perform basic tasks. The Admin API adds administrative capabilities. With the Admin Extensions
API, you can manage components of the VMware infrastructure.
This chapter includes the following topics:
n

“Access the vCloud Director Plug-In API,” on page 11

n

“User API Classes,” on page 12

n

“Admin API Classes,” on page 14

n

“Admin Extensions API Classes,” on page 15

n

“Parameters for vCloud Director Plug-In API Methods,” on page 16

Access the vCloud Director Plug-In API
Orchestrator provides an API Explorer to allow you to search the vCloud Director plug-in API and see the
documentation for JavaScript objects that you can use in scripted elements.
Procedure
1

Log in to the Orchestrator client as an administrator.

2

Access the API Explorer from either the Orchestrator client or from the Scripting tabs of the workflow,
policy, and action editors.

3

n

To access the API Explorer from the Orchestrator client, click Tools > API Explorer in the Orchestrator
client toolbar.

n

To access the API Explorer from the Scripting tabs of the workflow, policy, and action editors, click
Search API on the left.

To expand the hierarchical list of vCloud Director plug-in API objects, double-click the vCloud module
in the left pane.

What to do next
You can copy code from API elements and paste it into scripting boxes. For more information about API
scripting, see the vCenter Orchestrator Developer's Guide.

VMware, Inc.
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User API Classes
User API classes are typically readable by all users, and can be modified by users with appropriate rights.
With the User API, you can examine organizations and virtual datacenters (vDCs). You can create vApps in
the organizations and in vDCs, and manage the created vApps. You can control vApp networks and create
vApp templates and media files, such as ISO and floppy images. You can store vApp templates and media
files in catalogs for easy access and sharing between organizations and vDCs.
The following classes belong to the User API.

12

Class Name

Description

VclAccessLevel

Defines the access level type.

VclAccessSetting

Defines the level of access granted to the user or group referenced in the subject
element.

VclAccessSettings

Contains VclAccessSetting elements.

VclAllocationModel

Defines how resources are allocated in a vDC.

VclCapacityWithUsage

Defines the CPU and memory capacity that can be allocated from a vDC, and
optionally reports how much of that capacity is in use.

VclCatalog

Contains VclCatalogItem elements.

VclCatalogItem

Contains a reference to a cataloged entity, such as an image or a template.

VclCompositionItemParam

Defines a composition item.

VclComputeCapacity

Defines compute resources available in a vDC.

VclControlAccessParams

Appears in catalogs and vApps. All users can read the class, but only system
administrators can modify it.

VclCustomizationSection

Defines a vApp template customization settings section.

VclDhcpService

Defines the properties of the network's DHCP service.

VclEntityType

Basic entity type in the vCloud object model.

VclFenceMode

Defines how a network is connected to its parent network.

VclFile

Defines a transfer file storage item.

VclFilesList

Defines a list of transfer files.

VclFirewallPolicy

The policy enumeration type for a firewall rule.

VclFirewallRule

Defines a single firewall rule.

VclFirewallService

Defines the firewall service capabilities of a network.

VclGuestCustomizationSection

Defines guest customization settings.

VclInstantiationParams

Defines a list of VcloOvfSection elements to configure for instantiating a vApp.

VclIpAddressAllocationMode

Enumeration of IP address allocation modes.

VclIpAddresses

Defines a list of IP addresses.

VclIpRange

Defines a range of IP addresses available on a network.

VclIpRanges

Defines a list of IP ranges.

VclIpScope

Defines the address range, gateway, netmask, and other properties of a network.

VclLeaseSettingsSection

Defines the lease settings section for a vApp.

VclMedia

Used as the body of a request to upload virtual media, such as an ISO or a floppy
image. The element can also be used in the response.

VclMediaImageType

Enumeration of media image types.
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Class Name

Description

VclNatMappingMode

Enumeration of NAT mapping mode types.

VclNatOneToOneBasicRule

Defines the NAT basic rule for one to one mapping of internal and external IP
addresses from a network.

VclNatOneToOneVmRule

Defines the NAT rule for one to one mapping of virtual machine NIC and external IP
addresses from a network.

VclNatPolicy

Enumeration of NAT policy values.

VclNatPortForwardingRule

Defines the NAT rule for port forwarding between an internal IP or port and an
external IP or port.

VclNatRule

Defines a single NAT rule.

VclNatService

Defines the NAT capabilities of a network.

VclNatType

Enumeration of NAT type values.

VclNatVmRule

Defines the NAT rule for port forwarding between a virtual machine NIC or port and
an external IP or port.

VclNetworkAssignment

In a complex vApp, associates the network defined in each child vApp with a network
in the parent vApp.

VclNetworkConfigSection

Extends the VclOvfNetworkSection element by adding a link to a vCloud network
and a VclNetworkConfiguration element that defines the configuration of that
network.

VclNetworkConfiguration

Defines the properties of a vCloud network.

VclNetworkConnection

Defines the properties network connection.

VclNetworkConnectionSection

Defines a list of network cards existing in a virtual machine.

VclNetworkFeatures

Defines a set of network features.

VclOrgNetwork

Defines a network that is available in an organization.

VclOrganization

A high-level abstraction that provides a container and a unit of administration for a
collection of resources and users.

VclReference

A reference element.

VclResourceEntities

Contains resource entity elements in a vDC.

VclResourceReference

Defines a reference to a resource.

VclScreenTicket

Contains a string that represents a screen ticket, which is required to access a vApp
console.

VclTask

Whenever the result of a request cannot be returned immediately, the server creates
a task entity and returns its URL to the client. The client can use the URL in a
subsequent GET request, to obtain the current status of the task.

VclTaskStatus

Defines the current status of a task.

VclTasksInProgress

Contains VclTask elements owned by a containing entity, such as an organization.

VclTasksList

Contains VclTask elements.

VclVApp

Defines the result of an instantiation of a VclVAppTemplate element.

VclVAppNetworkConfiguration

Defines the configuration of a vApp network.

VclVAppTemplate

Provides an immutable description of a vApp. A VclVAppTemplate element is created
when you upload an OVF package to a vDC.

VclVdc

Defines a deployment environment for vApps.

VclVdcs

Defines a list of references to vDCs.

VclVirtualCpu

A helper class that accesses the VirtualCpu resource in the vCloud API.

VMware, Inc.
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Class Name

Description

VclVirtualDisk

A helper class that accesses the VirtualDisk resource in the vCloud API. The
VirtualDisk resource can be a disk or its controller.

VclVirtualMedia

A helper class that accesses the VirtualMedia resource in the vCloud API.

VclVirtualMemory

A helper class that accesses the VirtualMemory resource in the vCloud API.

VclVirtualNetworkCard

A helper class that accesses the VirtualNetworkCard resource in the vCloud API.

VclVmPendingQuestion

A question issued for a virtual machine in a waiting for input state.

VclVmQuestionAnswerChoice

An answer to a question issued for a virtual machine in a waiting for input state.

Admin API Classes
Admin API classes are typically readable by all users, but can be created and modified only by a system
administrator, organization administrator, or another privileged user.
With the Admin API, you can administrate and create organizations, vDCs, organization networks, and
authorization entities, such as roles, rights, users, and groups. You can create, delete, and modify a catalog of
templates and media files.
The following classes belong to the Admin API.
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Class Name

Description

VclAdminCatalog

A helper class for the AdminCatalog resource in the vCloud Admin API.

VclAdminOrgNetwork

A helper class for the OrgNetwork resource in the vCloud Admin API.

VclAdminOrganization

Provides an administrative view of an Organization.

VclAdminVdc

Provides an administrative view of a vDC.

VclAdminVdcParams

A helper class that contains input parameters for the addAdminVdc() method from
the VclAdminOrganization class.

VclAvailableNetworks

Contains references to network elements in a vDC.

VclGroup

Defines a group in the vCloud environment.

VclGroupList

Contains elements that reference groups in an organization.

VclLdapAuthenticationMechanism

Defines the authentication mechanism used by the LDAP service.

VclLdapConnector

Defines the type of the LDAP service.

VclNetworkPoolReferences

Contains elements that reference network pools in a provider vDC.

VclOrgEmailSettings

Defines the email settings for an organization.

VclOrgLdapGroupAttributes

Defines how a group is imported from LDAP, if VclOrgLdapMode is custom.

VclOrgLdapMode

Defines whether an organization is connected to an LDAP service, and whether it
uses the system default LDAP service or a custom LDAP service.

VclOrgLdapSettings

Defines the hostname and connection details for an organization's LDAP service,
if VclOrgLdapMode is custom.

VclOrgLdapUserSettings

Defines how LDAP attributes are used when importing a user, if
VclOrgLdapMode is custom.

VclOrgLeaseSettings

Defines default lease durations and policies for an organization.

VclOrgSettings

Establishes quotas and policies for an organization and contains elements that
specify how the organization connects to LDAP and email services.

VclProviderNetwork

A helper class for the ExternalNetwork resource in vCloud Admin API.

VclProviderVdc

Contains a collection of all the resources available in a vCloud.

VclProviderVdcCapacity

Defines the resource capacity for a provider vDC.
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Class Name

Description

VclRight

Defines a right in the system.

VclRightReferences

Contains ReferenceType elements that reference the predefined RightType
objects.

VclRole

Defines a role that has a collection of rights.

VclRootComputeCapacity

Defines compute capacity with units.

VclSmtpServerSettings

Specifies connection details for an organization's SMTP server, if
VclOrgEmailSettings is not set to use the default SMTP server.

VclUser

Defines a user in the vCloud environment.

VclUserParams

A helper class that passes parameters for creating and updating a user in an
organization.

VclUsersList

Contains elements that reference users in an organization.

Admin Extensions API Classes
Admin Extensions API classes can be created and modified only by a system administrator.
The Admin Extensions API is specific to VMware. With the Admin Extensions API, you can manage entities,
such as provider vDCs, network pools, and vCenter Server hosts.
The following classes belong to the Admin Extensions API.
Class Name

Description

VclImportVmAsVAppParams

Defines parameters for importing a virtual machnie as a vApp.

VclImportVmAsVAppTemplateParams

Defines parameters for importing a virtual machnie as a vApp template.

VclLicensingManagedServer

Captures a single set of metrics for a managed server for a given sample.

VclLicensingReport

A read-only licensing metric report.

VclLicensingReportSample

Defines a single licensing data collection point.

VclLicensingVirtualMachine

Defines a single set of virtual machine metrics.

VclManagedServerMetrics

Defines licensing metrics for managed servers.

VclNumericRange

Defines a range of integers.

VclResourcePool

Defines vSphere resource pool information.

VclShieldManagerParams

Defines credentials to a shield manager server.

VclVMWFencePoolParams

A helper class that passes parameters for creating VclVMWNetworkPool elements.

VclVMWHost

Defines a connection from the plug-in to a vCloud Director instance.

VclVMWNetworkPool

The base type for a network pool.

VclVMWNetworkPoolType

Defines a set of types that are used when creating network pools.

VclVMWPortGroupPoolParams

A helper class that passes parameters for creating VclVMWNetworkPool elements.

VclVMWProviderNetwork

The external network type.

VclVMWProviderNetworkParams

A helper class that passes parameters for creating VMWProviderNetwork
elements.

VclVMWProviderVdc

The extension representation of provider vDC type.

VclVMWProviderVdcParams

A helper class that passes parameters for creating VMWProviderVdc elements.

VclVMWVlanPoolParams

A helper class that passes parameters for creating VMWVlanPool elements.

VclVimObjectRef

Defines the MoRef and the type for a vSphere object.
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Class Name

Description

VclVimObjectRefs

Lists VimObjectRef elements.

VclVimObjectType

Defines a set of types that are used when referencing VIM objects.

VclVimServer

Defines the vSphere server information.

VclVimServerParams

A helper class that passes parameters to register a vSphere server.

VclVirtualMachineMetrics

Defines licensing metrics for virtual machines.

VclVmObjectRef

Defines vSphere object information about a virtual machine.

Parameters for vCloud Director Plug-In API Methods
Some getObject(String) methods require enumeration types, which are specific to the vCloud Director plugin, as input parameteres.
You can use the following values as parameters for the getObject(String) methods in the respective classes.
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Class Name

Method Name

Possible Values

VclEntityType

getObject(String):VclEntityType

AdminCatalog
AdminOrganization
AdminVdc
AdminOrgNetwork
Catalog
CatalogItem
Group
VimServer
VmwHost
VmwNetworkPool
VmwProviderNetwork
VmwProviderVdc
Media
OrgNetwork
Organization
ProviderNetwork
ProviderVdc
Right
Role
Task
TaskList
User
VApp
VAppTemplate
Vdc

VclHostSessionMode

getObject(String):VclHostSessionMode

PER_USER_SESSION
SHARED_SESSION

VclTaskStatus

getObject(String):VclTaskStatus

SUCCESS
ERROR
QUEUED
RUNNING
CANCELED

VclVMWNetworkPoolType

getObject(String):VclVMWNetworkPoolType

VLAN_POOL
FENCE_POOL
PORT_GROUP_POOL
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3

The vCloud Director plug-in workflow library contains workflows that allow you to run automated processes
related to the management of vCloud Director instances.
The workflows are grouped into categories depending on their functional area. You can integrate standard
workflows from the workflow library in custom workflows.
This chapter includes the following topics:
n

“Using the vCloud Director Plug-In Inventory,” on page 17

n

“Access the vCloud Director Plug-In Workflow Library,” on page 17

n

“Standard User Workflows,” on page 18

n

“Admin Workflows,” on page 20

n

“Admin Extension Workflows,” on page 22

n

“Sample Workflows,” on page 24

Using the vCloud Director Plug-In Inventory
The vCloud Director plug-in exposes all objects in the connected vCloud Director instances in the Inventory
view. You can use the Inventory view to add authorization elements or to run workflows on vCloud Director
objects.
You can enable the Use contextual menu in inventory option to display the workflows that are available for
an inventory object. When the option is enabled and you right-click an object in the Orchestrator inventory,
all available workflows for the object are displayed.

Access the vCloud Director Plug-In Workflow Library
You must use the Orchestrator client to access the elements from the vCloud Director plug-in workflow library.
Procedure
1

Log in to the Orchestrator client as an administrator.

2

Click the Workflows view in the Orchestrator client.
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Option

Action

Access the set of standard workflow
categories

In the hierarchical list, select Library > vCloud Director and expand the
selection.

Access the set of administrative
workflow categories

In the hierarchical list, select Library > vCloud Director > Admin and expand
the selection.
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Option

Action

Access the set of administrative
extension workflow categories

In the hierarchical list, select Library > vCloud Director > Admin >
Extension and expand the selection.

Access the set of complex sample
workflows

In the hierarchical list, select Library > vCloud Director Samples and expand
the selection.

Standard User Workflows
The vCloud Director workflow category contains standard workflows related to vCloud Director management.

Catalog Item Workflows
The Catalog Item workflow category contains workflows related to catalog item management.
You can access these workflows from Library > vCloud Director > Catalog Item.
Workflow Name

Description

Add Catalog Item

Adds a new item to a catalog. The new item can be a media file or a vApp template.

Delete Catalog Item

Deletes a catalog item from a catalog.

Update Catalog Item

Updates a catalog item.

Media Workflows
The Media workflow category contains workflows related to media management.
You can access these workflows from Library > vCloud Director > Media.
Workflow Name

Description

Clone Media

Clones a media file.

Delete Media

Deletes a media file.

Update Media

Updates a media file.

Upload Media

Uploads a media file. The uploaded media can be an ISO file or a floppy file.

Plug-In Configuration Workflows
The Plug-in Configuration workflow category contains workflows related to vCloud Director connection
management.
You can access these workflows from Library > vCloud Director > Plug-in Configuration.
Workflow Name

Description

Add Connection

Adds a new vCloud Director connection to the plug-in configuration.

Delete Connection

Deletes a vCloud Director connection from the plug-in configuration.

Task Workflows
The Task workflow category contains workflows related to task management.
You can access these workflows from Library > vCloud Director > Task.

18

Workflow Name

Description

Wait For Task

Waits for a task to be completed.
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vApp Workflows
The vApp workflow category contains workflows related to vApp management.
You can access these workflows from Library > vCloud Director > vApp.
Workflow Name

Description

Capture vApp

Captures a vApp as a vApp template.

Clone vApp

Clones a vApp.

Compose vApp

Composes a vApp from virtual machines of other vApps.

Delete vApp

Deletes a vApp.

Share vApp

Updates the sharing configuration of a vApp.

Update vApp

Updates a vApp.

vApp Power Workflows
The Power workflow category contains workflows related to vApp power management.
You can access these workflows from Library > vCloud Director > vApp > Power.
Workflow Name

Description

Deploy vApp

Deploys a vApp and optionally powers it on.

Discard Suspended State vApp

Discards the state of a suspended vApp.

Power Off vApp

Powers off a vApp. Does not free the resources reserved for the vApp.

Power On vApp

Powers on a vApp.

Reboot vApp

Sends a notification to the vApp's guest virtual machines to reboot.

Reset vApp

Resets a vApp.

Shutdown vApp

Sends a notification to the vApp's guest virtual machines to shut down.

Suspend vApp

Suspends a vApp. Does not free the resources reserved for the vApp.

Undeploy vApp

Stops or suspends a vApp and frees the resources reserved for the vApp.

VM Workflows
The VM workflow category contains workflows related to virtual machine management.
You can access these workflows from Library > vCloud Director > vApp > VM.
Workflow Name

Description

Delete VM

Deletes a virtual machine.

Eject Media

Ejects media from a virtual machine.

Insert Media

Inserts media into a virtual machine.

VM Power Workflows
The Power workflow category contains workflows related to virtual machine power management.
You can access these workflows from Library > vCloud Director > vApp > VM > Power.
Workflow Name

Description

Deploy VM

Deploys a virtual machine and optionally powers it on.
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Workflow Name

Description

Discard Suspended State VM

Discards the state of a suspended virtual machine.

Power Off VM

Powers off a virtual machine. Does not free the resources reserved for the virtual machine.

Power On VM

Powers on a virtual machine.

Reboot VM

Sends a notification to the virtual machine guest to reboot.

Reset VM

Resets a virtual machine.

Shutdown VM

Sends a notification to the virtual machine guest to shut down.

Suspend VM

Suspends a virtual machine. Does not free the resources reserved for the virtual machine.

Undeploy VM

Stops or suspends a virtual machine and frees the resources reserved for the virtual machine.

VM Screen Workflows
The Screen workflow category contains workflows related to virtual machine screen management.
You can access these workflows from Library > vCloud Director > vApp > VM > Screen.
Workflow Name

Description

Acquire Ticket

Acquires a ticket for the remote console of a virtual machine.

Get Thumbnail

Gets a screenshot of a virtual machine's desktop.

vApp Template Workflows
The vApp Template workflow category contains workflows related to vApp template management.
You can access these workflows from Library > vCloud Director > vApp Template.
Workflow Name

Description

Delete vApp Template

Deletes a vApp template.

Download vApp Template

Downloads a vApp template as an OVF.

Instantiate vApp Template

Instantiates a vApp template as a vApp.

Update vApp Template

Updates a vApp template.

Upload vApp Template

Uploads an OVF as a vApp template.

Admin Workflows
The Admin workflow category contains workflows related to vCloud Director administrative management.

Catalog Workflows
The Catalog workflow category contains workflows related to catalog management.
You can access these workflows from Library > vCloud Director > Admin > Catalog.
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Workflow Name

Description

Add Catalog

Adds a catalog to an organization.

Delete Catalog

Deletes a catalog.

Publish Catalog

Publishes or unpublishes a catalog to all organizations external to the catalog's organization.

Share Catalog

Updates the sharing configuration of a catalog.

Update Catalog

Updates a catalog.
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Group Workflows
The Group workflow category contains workflows related to group management.
You can access these workflows from Library > vCloud Director > Admin > Group.
Workflow Name

Description

Delete Group

Deletes a group.

Import Group

Imports a group from the configured directory service to an organization.

Update Group

Updates a group.

Network Workflows
The Network workflow category contains workflows related to organization network management.
You can access these workflows from Library > vCloud Director > Admin > Network.
Workflow Name

Description

Add Org Network

Adds an organization network to an organization.

Delete Org Network

Deletes an organization network.

Organization Workflows
The Organization workflow category contains workflows related to organization management.
You can access these workflows from Library > vCloud Director > Admin > Organization.
Workflow Name

Description

Add Organization

Adds an organization to a vCloud Director instance.

Delete Organization

Deletes an organization.

Update Organization

Updates an organization.

Role Workflows
The Role workflow category contains workflows related to role management.
You can access these workflows from Library > vCloud Director > Admin > Role.
Workflow Name

Description

Add Role

Adds a role to a vCloud Director instance.

Delete Role

Deletes a role.

Update Role

Updates a role.

User Workflows
The User workflow category contains workflows related to user management.
You can access these workflows from Library > vCloud Director > Admin > User.
Workflow Name

Description

Add User

Adds a user to an organization or imports it from LDAP.
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Workflow Name

Description

Delete User

Deletes a user.

Update User

Updates a user.

vDC Workflows
The vDC workflow category contains workflows related to vDC management.
You can access these workflows from Library > vCloud Director > Admin > vDC.
Workflow Name

Description

Add vDC

Adds a vDC to an organization.

Delete vDC

Deletes a vDC.

Update vDC

Updates a vDC.

Admin Extension Workflows
The Extension workflow category contains workflows related to vCloud Director administrative extensions
management.

Licensing Reports Workflows
The Licensing Reports workflow category contains workflows related to licensing reports management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > Licensing Reports.
Workflow Name

Description

Print Licensing Reports

Prints the licensing reports of a vCloud Director instance.

VIM Server Workflows
The VIM Server workflow category contains workflows related to vCenter Server management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VIM Server.
Workflow Name

Description

Import VM as vApp

Imports a virtual machine from an available vCenter Server as a vApp.

Import VM as vApp Template

Imports a virtual machine from an available vCenter Server as a vApp template.

Reconnect VIM Server

Tries to force a reconnection to a vCenter Server from its vCloud Director instance.

Register VIM Server

Registers a vCenter Server to a vCloud Director instance.

Unregister VIM Server

Unregisters a vCenter Server.

Update VIM Server

Updates a vCenter Server.

VMW Host Workflows
The VMW Host workflow category contains workflows related to ESX host management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW Host.
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Workflow Name

Description

Enable VMW Host

Enables or disables an ESX host.

Prepare VMW Host

Prepares or unprepares an ESX host.
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Workflow Name

Description

Repair VMW Host

Tries to repair an ESX host.

Upgrade VMW Host

Tries to upgrade an ESX host.

VMW Network Pool Workflows
The VMW Network Pool workflow category contains workflows related to ESX network pool management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW Network
Pool.
Workflow Name

Description

Add VMW Network Pool

Adds a network pool to a vCloud Director instance.

Delete VMW Network Pool

Deletes a network pool.

Update VMW Network Pool

Updates a network pool.

VMW Provider Network Workflows
The VMW Provider Network workflow category contains workflows related to ESX provider network
management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW Provider
Network.
Workflow Name

Description

Add VMW Provider Network

Adds an external network to a vCloud Director instance.

Delete VMW Provider Network

Deletes an external network.

Update VMW Provider Network

Updates an external network.

VMW Provider vDC Workflows
TThe VMW Provider vDC workflow category contains workflows related to ESX provider vDC management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW Provider
vDC.
Workflow Name

Description

Add VMW Provider vDC

Adds a provider vDC to a vCloud Director instance.

Delete VMW Provider vDC

Deletes a provider vDC.

Update VMW Provider vDC

Updates a provider vDC.
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Sample Workflows
The vCloud Director Samples workflow category contains complex provisioning workflows. The sample
workflows implement workflows from the standard vCloud Director workflow category to perform multistep
automated processes in the cloud. You can run the sample workflows to test standard provisioning use cases.

Run the Provision New Organization with Default Settings Workflow
You can run a workflow to provision an organization that uses default settings. You can modify the settings
after the organization is created.
An organization is the fundamental vCloud Director grouping. An organization contains users, the vApps
they create, and the resources the vApps use. An organization can be a department in your own company or
an external customer that you are providing cloud resources to.
The new organization uses the following default settings.
n

Is enabled and allows publication of catalogs to all organizations.

n

Does not use LDAP.

n

Uses the default SMTP and notification settings from the vCloud Director instance.

n

Has an unlimited quota for running virtual machines and stored virtual machines.

n

Contains one vDC and two catalogs, one public and one private.

Prerequisites
n

Verify that the vCloud Director plug-in is enabled and configured in the Orchestrator configuration
interface.

n

Verify that you are logged in to the Orchestrator client as an administrator.

Procedure
1

Click the Workflows view in the Orchestrator client.

2

In the workflows hierarchical list, select Library > vCloud Director Samples to navigate to the Provision
new Organization with default settings workflow.

3

Right-click the Provision new Organization with default settings workflow and select Start workflow.

4

Select the vCloud Director instance on which to add the new organization.

5

Select the provider vDC and network pool to be used by the new organization.

6

Specify the organization options.

7

8

a

Type a name and a full name of the organization.

b

(Optional) Modify the default lease settings.

Specify the organization vDC options.
a

Select the allocation model for the vDC. You can select AllocationVApp, AllocationPool, or
ReservationPool.

b

Provide the resource reservation values.

Select whether to provision the new organization with default media, vApp template, and vApp.
If you select Yes, provide the required media, vApp template, and vApp parameters.

9
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Click Submit to run the workflow.
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Run the Provision New Media New vApp Template and New vApp Workflow
You can run a workflow to provision a given organization with new media, a new vApp template, and a new
vApp.
Prerequisites
n

Verify that the vCloud Director plug-in is enabled and configured in the Orchestrator configuration
interface.

n

Verify that you are logged in to the Orchestrator client as an administrator.

n

Verify that you have access to an existing organization.

Procedure
1

Click the Workflows view in the Orchestrator client.

2

In the workflows hierarchical list, select Library > vCloud Director Samples to navigate to the Provision
new Media new vApp Template and new vApp workflow.

3

Right-click the Provision new Media new vApp Template and new vApp workflow and select Start
workflow.

4

Select an organization in which to provision the new media, vApp template, and vApp.

5

Specify the media options.

6

7

8

a

Type a name and a description of the media.

b

Select the image type of the media. You can select ISO or floppy.

c

Type the local path to the media image file.

Specify the vApp template options.
a

Type a name and a description of the vApp template.

b

Type the local path to the vApp template OVF file.

Specify the vApp options.
a

Type a name and a description of the vApp.

b

(Optional) Modify the default lease settings.

Click Submit to run the workflow.

The workflow uploads the media and the vApp template and instantiates the vApp from the vApp template
with default parameters. Using the default parameters, the instantiated vApp is not deployed and not powered
on. The EULA is accepted and no networks are connected.

Run the Provision New Network Pool Backed by a New DVS Port Group Workflow
You can run a workflow to create a vCloud network pool that is backed by newly created vSphere port groups.
A network pool is a collection of virtual machine networks that are available to be consumed by vDCs to create
vApp networks and by organizations to create organization networks. Network traffic on each network in a
pool is isolated from all other networks at layer 2 (Data Link Layer).
Prerequisites
n

Verify that the vCloud Director plug-in is enabled and configured in the Orchestrator configuration
interface.

n

Verify that you are logged in to the Orchestrator client as an administrator.
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n

Verify that you have access to a vCenter Server that is within the vCloud Director instance.

Procedure
1

Click the Workflows view in the Orchestrator client.

2

In the workflows hierarchical list, select Library > vCloud Director Samples to navigate to the Provision
new network pool backed by a new DVS port group workflow.

3

Right-click the Provision new network pool backed by a new DVS port group workflow and select Start
workflow.

4

Select the vCloud Director instance in which to add the new network pool.

5

Select the vCenter Server from the vCloud Director instance to back the new port groups.

6

Type the name of the cluster from the vCenter Server to back the new port groups.

7

Type the Managed Object Reference (MoRef) ID of the distributed virtual switch (DVS) to contain the new
port groups.
You can check the MoRef ID by selecting the DVS from the vCenter Server 4.1 Inventory view, and
searching for the id value on the General tab in the right pane.

8

Specify the options for the new port groups.
a

Type the number of port groups to be created.

b

Select the type of the port groups. You can select earlyBinding, lateBinding, or ephemeral.

c

Type a name prefix for the port groups.

d

Type the number of DVS ports to be created for each port group.

9

Type a name and a description of the network pool.

10

Click Submit to run the workflow.

The workflow first creates a number of port groups with the specified number of ports, and then creates a
network pool backed by those port groups. The created port groups are backed by an existing distributed
virtual switch from a cluster inside one of the vCenter Server hosts attached to the vCloud Director instance.

Run the Provision Provider vDC on Top of New ESX Server Workflow
You can run a workflow to attach a new ESX host to the vCloud Director instance and optionally create a new
provider vDC that is backed by the attached ESX host.
A provider vDC is a group of compute, memory, and storage resources from one vCenter Server host. You can
use vCloud Director to allocate portions of a provider vDC to your organizations.
Prerequisites
n

Verify that the vCloud Director plug-in is enabled and configured in the Orchestrator configuration
interface.

n

Verify that you are logged in to the Orchestrator client as an administrator.

n

Verify that you have access to a vCenter Server that is within the vCloud Director instance.

Procedure
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1

Click the Workflows view in the Orchestrator client.

2

In the workflows hierarchical list, select Library > vCloud Director Samples to navigate to the Provision
provider vDC on top of new ESX server workflow.

3

Right-click the Provision provider vDC on top of new ESX server workflow and select Start workflow.
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4

Select the vCloud Director instance on which to attach the ESX host.

5

Select the vCenter Server from the vCloud Director instance on which the ESX host is attached.

6

Specify the cluster options.
a

Type the name of the cluster.
NOTE If the cluster does not exist, the workflow creates it.

7

8

b

Select whether to enable distributed resource scheduling (DRS) and high availability (HA) for the
cluster.

c

Type the name of the NFS-based datastore to share with the other ESX hosts of the vCloud.

d

Type the server IP or server name of the NFS-based datastore.

e

Type the name of the shared folder inside the NFS-based datastore.

Specify the ESX host options.
a

Type an IP address of the ESX host to be added to the cluster.

b

Provide the required authentication parameters.

Select whether to create a provider vDC that is backed by the attached ESX host.
If you select Yes, specify the provider vDC options.

9

a

Type a name and a description of the provider vDC.

b

Select whether to enable the provider vDC.

Click Submit to run the workflow.

The ESX host is attached to one vCenter Server host inside the vCloud and it is included in one cluster inside
the vCenter Server host. If the cluster does not exist, the workflow creates it. An existing NFS shared datastore
is attached to the ESX host. After the ESX host is ready, you can create a provider vDC inside the vCloud. The
new ESX host backs the new provider vDC.

Run the Run a Full Provisioning Cycle Workflow
You can run a workflow to configure the infrastructure on a vCloud Director instance.
The workflow performs the following actions.
n

Attaches an existing vCenter Server to the vCloud Director instance.

n

Creates a new provider vDC backed by an existing resource pool from the vCenter Server.

n

Prepares all ESX hosts from the provider vDC.

n

Creates a new provider network backed by an existing network from the vCenter Server.

n

Adds a new organization.

n

Adds a new organization vDC to the organization backed by the provider vDC.

n

Adds a new bridged organization network to the organization backed by the provider network.

n

Adds a new catalog to the organization.

n

Uploads a new media and adds it to the catalog.

Prerequisites
n
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interface.
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n

Verify that you are logged in to the Orchestrator client as an administrator.

n

Verify that you have access to a vCenter Server that is within the vCloud Director instance.

n

Verify that you have access to a vShield Manager.

Procedure
1

Click the Workflows view in the Orchestrator client.

2

In the workflows hierarchical list, select Library > vCloud Director Samples to navigate to the Run a full
provisioning cycle workflow.

3

Right-click the Run a full provisioning cycle workflow and select Start workflow.

4

Select the vCloud Director instance on which to set up the infrastructure.

5

Provide the required parameters for the vCenter Server to be attached to the vCloud Director instance.

6

Provide the required parameters for the vShield Manager to be used with the vCenter Server.

7

Specify the provider vDC options.
a

Type the Managed Object Reference (MoRef) ID of the resource pool from the vCenter Server that
will back the new provider vDC.
You can check the MoRef ID by selecting the resource pool from the vCenter Server 4.1 Inventory
view, and searching for the id value on the General tab in the right pane.

8

b

(Optional) Create an array of MoRef IDs of the datastores from the vCenter Server shared by all the
ESX hosts from the resource pool.

c

Provide common credentials for all ESX hosts.

d

Type a name and a description of the new provider vDC.

Specify the provider network options.
a

Type a name and a description of the new provider network.

b

Provide the required network configuration parameters.

c

Type the MoRef ID of the network from the vCenter Server that backs the new provider network.
You can check the MoRef ID by selecting the network from the vCenter Server 4.1 Inventory view,
and searching for the id value on the General tab in the right pane.

9

Specify the organization options.
a

Type a name, a full name, and a description of the new organization.
The name is used as the unique identifier in the full URL with which users log in to this organization.
You can only use alphanumeric characters. The full name appears in the vCloud Director application
header when users log in.

10

11
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b

(Optional) Modify the default policy values.

c

Type the default email address of the notification sender.

Specify the organization vDC options.
a

Type a name and a description of the new organization vDC.

b

Select the allocation model for the vDC. You can select AllocationVApp, AllocationPool, or
ReservationPool.

c

Provide the resource reservation values.

Type the name of the new organization network.
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12

Provide the required parameters for the new catalog.

13

Specify the media options.

14

VMware, Inc.

a

Type a name and a description of the media.

b

Select the image type of the media. You can select ISO or floppy.

c

Type the local path to the media image file.

Click Submit to run the workflow.

29

Using the vCenter Orchestrator Plug-In for vCloud Director 1.0

30

VMware, Inc.

Index

A
API access 11
API classes
Admin 14
Admin Extensions 15
User 12
API methods, parameters 16
audience 5

C
components 7
configuration 8
configuration process 9

F
functional prerequisites 8

I
installation 8
installation process 8
introduction 7
Inventory 17

O
Orchestrator 8

S
sample provisioning workflows
Provision new Media new vApp Template and
new vApp 25
Provision new network pool backed by a new
DVS port group 25
Provision new Organization with default
settings 24
Provision provider vDC on top of new ESX
server 26
Run a full provisioning cycle 27
scripting API 11

workflows
administrative 20
administrative extensions 22
catalog 20
catalog item 18
ESX host management 22
ESX network pool management 23
ESX provider network management 23
ESX provider vDC management 23
extension 22
group 21
licensing reports 22
media 18
network 21
organization 21
plug-in configuration 18
provisioning 24
role 21
sample 24
standard 18
task 18
user 21
vApp 19
vApp power management 19
vApp template 20
vCenter Server management 22
vDC 22
VIM server 22
virtual machine management 19
virtual machine power management 19
virtual machine screen management 19
VMW host 22
VMW network pool 23
VMW provider network 23
VMW provider vDC 23

V
vCloud Director 8

W
workflow library 17
workflow library access 17

VMware, Inc.

31

Using the vCenter Orchestrator Plug-In for vCloud Director 1.0

32

VMware, Inc.

